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Copyright Information

Copyright 2001, Investment Intelligence Systems Corporation. All Rights Reserved.

The information contained in this manual and accompanying software program is
copyrighted and all its rights are reserved by Investment Intelligence Systems
Corporation (IISC). IISC reserves the right to make periodic modifications of this
product without obligation to notify any person or entity of such revision. Copying,
duplicating, selling, or otherwise distributing any part of this product without the prior
consent of an authorized representative of IISC is prohibited.

JSheet and HyperSheet are registered trademarks of Investment Intelligence Systems
Corporation.

Disclaimer of Warranties

The software and users manuals are provided “as is” and without express or limited
warranty of any kind by either IISC or anyone who has been involved in the creation,
production, or distribution of the software, including, but not limited to the implied
warranties of the merchantability and fitness for a particular purpose. The entire risk as
to quality and performance of the software and users manuals is with you. Should the
software and users manuals prove defective, you (and IISC or anyone else who has been
involved in the creation, production, or distribution of the software) assume the entire
cost of all necessary servicing, repairs, or correction.

Some states do not allow the exclusion of implied warranties, so the above exclusion may
not apply to you.

Limitation of Liability

In no event will IISC or any other person involved in the creation, production, or
distribution of the software be liable to you on account of any claim for any damages,
including any lost profits, lost savings, or other special, incidental, consequential, or
exemplary damages, including but not limited to any damages assessed against or paid by
you to any third party, arising out of the use, inability to use, quality, or performance of
such software and users manuals, even if IISC or any other such person or entity has been
advised of the possibility for such damages, or for any claim by any party. In addition,
IISC or any other person involved in the creation, production, or distribution of the
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software shall not be libel for any claim by you or any other party for damages arising out
of the use, inability to use, quality, or performance of such software and users manuals,
based upon principals of contract warranty, negligence, strict liability for the negligence
of IISC or other tort, breach of any statutory duty, principals of indemnity or
contribution, the failure of any remedy to achieve its essentials purpose, or otherwise.

Some states do not allow the limitation or exclusion of liability for incidental or
consequential damages, so the above limitation may not apply to you.
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About This Guide
This Guide contains information about:

• your application package, including media content, hardware
requirements, and software requirements.

• how to install and configure JSheet Server, JSheet Builder,
JSheet Client, Orbix, and ODBC.

• how to set up your web server to run JSheet demos.

• how to run JSServer/JSheet demos.

• the JSServer menu structure, as well as the various features
of the JSServer interface.

• how to use JSServer Admin to administrate the JSServer
configuration and preferences.

• server configuration and startup, as well as how to add a
user.

• how to set up and run the load balancing application within
JSheet.
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Your Application Package
Your application package consists of the application installation CD-
ROM and this Installation and Administration Guide. The installation
process initializes the system configuration with defaults that are
appropriate for most purposes.

To access the JSheet documentation, double-click the doc.htm file found
in the root directory of the CD-ROM. This file contains hyperlinks to the
individual user guides. For distribution purposes, this Guide and the
other individual documents can be found on the CD-ROM in the doc
directory. For your convenience, the documentation is provided in two
formats: .htm and .pdf. The .htm format requires a browser and the .pdf
format requires Adobe Acrobat Reader.

If you are installing JSheet on the Windows platform, there is a windows
directory on the CD-ROM installation media that contains the
subdirectories listed in the following table.

Windows Directory Contains
\ Install files for the Windows NT JSheet products.
\builder Install files for JSBuilder only. Double-click setup.exe in this

directory and follow the installation prompts to install JSBuilder.
\client Install files for JSClient only. Double-click setup.exe in this

directory and follow the installation prompts to install JSClient.
\server Install files for JSServer only. Double-click setup.exe in this

directory and follow the installation prompts to install JSServer.

If you are installing JSheet on the Unix platform, there is a unix directory
on the CD-ROM installation media that contains the subdirectories listed
in the following table.

Unix Directory Contains
\solaris Install files for the Sun Solaris Unix platform. Execute solinst.bin

and follow the installation prompts to install the JSheet products.
\hp Install files for the HP-UX Unix platform. Execute hpinst.bin and

follow the installation prompts to install the JSheet products.
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The 3rdparty directory on the CD-ROM installation media contains the
subdirectories listed in the following table.

3rdparty Directory Contains
\odbc\unix Install files for a 30-day product evaluation copy of Merant DataDirect

Connect ODBC 3.50 for the Unix platform. Execute install.sh and follow
the installation prompts to install. For detailed information or support
regarding this software, please access the manufacturer’s web site:
http://www.merant.com/products/. Merant DataDirect Connect ODBC
documentation can be found at:
http://www.merant.com/products/datadirect/download/docs/dochome.asp.
Should you need the licensed version, please contact our Sales department
at http://www.jsheet.com.

\odbc\windows Install files for a 30-day product evaluation copy of Merant DataDirect
Connect ODBC 3.50 for Windows 9x and Windows NT. Double-click
setup.exe and follow the installation prompts to install. For detailed
information or support regarding this software, please access the
manufacturer’s web site: http://www.merant.com/products/. Merant
DataDirect Connect ODBC documentation can be found at:
http://www.merant.com/products/datadirect/download/docs/dochome.asp.
Should you need the licensed version, please contact our Sales department
at http://www.jsheet.com.

\orbix\unix Install files for the optional CORBA installation. Execute orbinst.sh to
install. Prior to installing, please view the readme.txt file in this
directory. For detailed information or support regarding this software,
please access the manufacturer’s web site: http://www.iona.com/products/.
Iona Orbix 3.0 documentation can be found at:
http://www.iona.com/docs/orbix/orbix30.html.

\orbix\windows Install files for the optional CORBA installation. Double-click setup.exe
and follow the installation prompts to install. For detailed information or
support regarding this software, please access the manufacturer’s web site:
http://www.iona.com/products/. Iona Orbix 3.0 documentation can be
found at: http://www.iona.com/docs/orbix/orbix30.html.
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The doc directory on the CD-ROM installation media contains the
subdirectories listed in the following table.

Doc Directory Contains
\doc\htm Includes all of the end-user product documentation in htm format.
\doc\htm\jsbldrug The JSheet Builder User Guide. Provides a complete reference to

the functionality of JSheet Builder, the JSheet component that is
used to open, edit, and save workbook files before they are
published to web sites. Simple spreadsheet templates, dynamic
data analysis, and comprehensive analytical applications for
enterprise-wide deployment are discussed in this book.

\doc\htm\jsfunctn The JSheet Functions manual. Includes all of the functions that
can be used in JSheet to perform data calculations, return range
information, and return information on settings, selections, and
status. The JSheet functions are presented alphabetically,
complete with syntax structures, return values, definitions,
examples, and related functions.

\doc\htm\jsheetug The JSheet User Guide. Provides step-by-step instructions on
how to use the visual interface to the JSheet engine. The features
and functionality of the spreadsheet matrix, menus, palettes, and
optional charting module are discussed.

\doc\htm\progrmgd The Programmer’s Guide. This book explains how to put the
JSheet applet into a web page and how to call the API from Java
and JavaScript.

\doc\htm\instladm The Installation and Administration Guide. This book contains
information about the hardware and software requirements and
how to install and configure your JSheet components.

\doc\pdf All of the end-user product documentation in pdf format.
\doc\pdf\jsbldrug The JSheet Builder User Guide. Provides a complete reference to

the functionality of JSheet Builder, the JSheet component that is
used to open, edit, and save workbook files before they are
published to web sites. Simple spreadsheet templates, dynamic
data analysis, and comprehensive analytical applications for
enterprise-wide deployment are discussed in this book.

\doc\pdf\jsfunctn The JSheet Functions manual. Includes all of the functions that
can be used in JSheet to perform data calculations, return range
information, and return information on settings, selections, and
status. The JSheet functions are presented alphabetically,
complete with syntax structures, return values, definitions,
examples, and related functions.
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\doc\pdf\jsheetug The JSheet User Guide. Provides step-by-step instructions on
how to use the visual interface to the JSheet engine. The features
and functionality of the spreadsheet matrix, menus, palettes, and
optional charting module are discussed.

\doc\pdf\progrmgd The Programmer’s Guide. This book explains how to put the
JSheet applet into a web page and how to call the API from Java
and JavaScript.

\doc\pdf\instladm The Installation and Administration Guide. Contains information
about the hardware and software requirements and how to install
and configure your JSheet components.

System Requirements
Before you attempt to install JSheet, make certain your configuration
meets or exceeds the system requirements detailed in this section.
Requirements are provided for Windows NT, Sun Solaris, and HP-UX.

Windows NT Hardware Requirements
The following hardware represents the minimum requirements for
installing and running JSheet on Windows NT:

• Intel Pentium-based personal computer

• Hard disk space: 40 MB for JSServer; 25 MB for JSBuilder,
10 MB for JSheet Client

• 64 MB RAM available for JSheet Client (128 MB
recommended)

• 256 MB RAM available for JSServer (512 MB
recommended)

• CD-ROM drive

• Video display capable of 800x600 screen resolution

Your application runs in virtual memory; available RAM directly affects
the speed of the program.
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Windows NT Software Requirements
Before you run the application, the following software requirements must
be met:

• JSServer: Microsoft Windows NT 4.0 and web server (if
supporting browser-based clients)

• JSBuilder: Microsoft Windows NT 4.0

• JSClient: JDK/JRE 1.1.4 or greater (for running Client as a
Java application or within appletviewer), or a web browser
supporting Java 1.1.4 or greater

• JSAdmin: JDK/JRE 1.2.2 or higher

IMPORTANT: JSheet is not supported on the Windows 2000
platform. However, at the time of this writing, there are no known issues
on this platform.

Sun Solaris Hardware Requirements
The following hardware represents the minimum requirements for
installing and running JSheet on Sun Solaris:

• Sparc-based computer

• Hard disk space: 40 MB for JSServer; 25 MB for JSBuilder;
10 MB for JSheet Client

• 64 MB RAM; 56 MB free disk space

• CD-ROM drive

• Video display capable of 800x600 screen resolution

• System temp directory with 50 MB of free space
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IMPORTANT: If more than a few users are to be served with
JSServer, a minimum of 128 MB RAM is recommended.

Sun Solaris Software Requirements
Before you run the application, the following software requirements must
be met:

• JSServer: Solaris for Sparc, version 2.5 or greater and web
server (if supporting browser-based clients)

• JSBuilder: Solaris for Sparc, version 2.5 or greater

• JSClient: JDK/JRE 1.1.4 or greater (for running Client as a
Java application or within appletviewer), or a web browser
supporting Java 1.1.4 or greater

HP-UX Hardware Requirements
The following hardware represents the minimum requirements for
installing and running JSheet on HP-UX:

• PA-RISC-based computer

• Hard disk space: 32 MB for JSServer; 15 MB for JSBuilder;
5 MB for JSheet Client

• 64 MB RAM; 56 MB free disk space

• CD-ROM drive

• Video display capable of 800x600 screen resolution

• System temp directory with 50 MB of free space

IMPORTANT: If more than a few users are to be served with
JSServer, a minimum of 128 MB RAM is recommended.
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HP-UX Software Requirements
Before you run the application, the following software requirements must
be met:

• JSServer: HP-UX 10.20 or greater and web server (if
supporting browser-based clients)

• JSBuilder: HP-UX 10.20 or greater

• JSClient: JDK/JRE 1.1.4 or greater (for running Client as a
Java application or within appletviewer), or a web browser
supporting Java 1.1.4 or greater

Installing on Windows NT
This section explains how to install the JSheet Server, Builder, and
Client, as well as Orbix, the CORBA implementation on Windows NT.
For information on installing these JSheet components on Sun Solaris or
HP-UX, refer to the corresponding sections later in this Guide.

To install your JSheet applications on Windows NT:

1. Insert the JSheet Products CD. If the JSheet Installation
does not load automatically, manually run autorun.exe in the
root directory of the JSheet Products CD.

2. Choose the product package to install: Server, Builder, or
Client. You can customize your choice before completing
the installation.

3. Enter your name and company name.
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4. Choose the installation type and location. To customize
your installation selections, choose the Custom option.

5. Choose the Program folder for your JSheet Products.

6. Enter the name of the machine on which JSServer will run,
followed by the network domain. For example, enter demo
as the machine and jsheet.com as the domain to specify
that JSServer will run on the machine demo.jsheet.com.

7. Enter the ports for the Orbix daemon and Orbix server.
(Retain the defaults 1570 and 1571, respectively, if you are
unsure.)

8. If you are overwriting an existing installation of the JSheet
products and want to retain the existing user and group
permission files, choose the default Maintain Existing
Information option when prompted.

9. Depending upon your distribution, there may be 30-day
evaluation license files on your CD-ROM. If you received
an evaluation version, copy the jsserver.dat and
jsbuilder.dat license files from the root directory of the
installation CD to the directory where JSheet is installed.
(This is typically C:/Program Files/.) If you purchased
JSheet, contact your sales representative to obtain your
personalized license files.

10. The programs can be run from the Start/Programs/JSheet
1.0 program group.



10 Installation and Administration Guide

Setting Up Your Web Server to Run
JSheet Demos
The Demos subdirectory of the JSHEET directory needs to be added as
an available directory in your web server, either as a physical directory in
your default web path or as a virtual directory. To do this, reference the
directions for your specific web server software to ensure you add the
directory according to the requirements of your web server. Once the
Demos directory is available through your web server, opening the
index.html file will provide links to the JSheet demos.

IMPORTANT: If you are copying the JSheet demo files to another
location, or creating .html files to work with JSServer, you must
reference the proper .jar and .js files. If you chose to install the Client
files, the .jar and .js files also will be placed in the JSHEET\Client
directory for your convenience. These .jar files can also be copied to the
class path of your local browser for faster loading of the JSheet applets.

Installing JSheet Documentation
IISC provides HTML documentation for the JSheet products in the
documentation directory of the CD. The files and folders in this directory
can be accessed from the CD or copied to your hard drive for local
access. Refer to the docs.htm file for information on the JSheet
documentation.

Installing on Sun Solaris
This section explains how to install the JSheet Server, Builder, and
Client on Sun Solaris. The JSServer executable can be run as a normal
user. It is recommended that a specific user, jsheet, be created for this
purpose.

IMPORTANT: You must be root to install JSheet Products.
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To install your JSheet applications on Sun Solaris:

1. Run solinst.bin from the /unix/solaris directory.

2. Choose the installation location.

3. Choose the product package to install: Server, Builder, or
Client. To customize your installation selections, choose
the Custom option.

4. Enter your user and company name, the owner and group,
and the server name.

NOTE: The JSServer executable owner should be a user
other than root. It is recommended that a specific user
(jsheet) be created for this purpose. The owner will run the
JSServer executable and will own all of the files created by
JSClient. The group and owner setting is jsheet by default,
but can be set to any valid group.

5. Enter the server name of the machine on which JSServer
will run, including the network domain. For example, enter
demo.jsheet.com as the server name to specify that
JSServer will run on the machine demo in the domain
jsheet.com.

6. If you are overwriting an existing installation of the JSheet
products and want to retain the existing user and group
permission files, choose the Maintain Existing
Information option when prompted.

7. Copy the jsserver.dat and jsbuilder.dat license files from
the root directory of the installation CD to the location
where JSheet is installed. The environment variable



12 Installation and Administration Guide

JSHEET must be set to the installation directory before
running the JSheet Server.

After the environment is set up, use the command $JSHEET/bin/JSServer
to start the JSheet Server. Run $JSHEET/bin/JSBuilder to start JSBuilder.

Setting Up Your Web Server to Run
JSheet Demos
The Demos subdirectory of the $JSHEET directory needs to be added as
an available directory in your web server, either as a physical directory in
your default web path or as a virtual directory. To do this, reference the
directions for your specific web server software to ensure you add the
directory according to the requirements of your web server. Once the
Demos directory is available through your web server, opening the
index.html file will provide links to the JSheet demos.

IMPORTANT: If you are copying the JSheet demo files to another
location, or creating .html files to work with JSServer, you must
reference the proper .jar and .js files. If you chose to install the Client
files, the .jar and .js files also will be placed in the $JSHEET/Client
directory for your convenience. These .jar files also can be copied to the
Class path of your local browser for faster loading of the JSheet applets.

Installing JSheet Documentation
IISC provides HTML documentation for the JSheet products in the
documentation directory of the CD. The files and folders in this directory
can be accessed from the CD or copied to your hard drive for local
access. Refer to the docs.htm file for information on the JSheet
documentation.
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Installing on HP-UX
This section explains how to install the JSheet Server, Builder, and
Client on HP-UX. The JSServer executable should be run as a normal
user. It is recommended that a specific user, jsheet, be created for this
purpose. The JSServer user owns all of the files created by Clients.

IMPORTANT: You must be root to install JSheet Products.

To install your JSheet applications on HP-UX:

1. Run hpinst.bin from the /unix/hp directory.

2. Choose the installation location.

3. Choose the product package to install: Server, Builder, or
Client. To customize your installation, choose Custom.

4. Enter your user and company name, the owner and group,
and the server name.

NOTE: The JSServer executable owner should be a user
other than root. It is recommended that a specific user
(jsheet) be created for this purpose. The owner will run the
JSServer executable and will own all of the files created by
Clients. The group setting is bin by default, but can be set
to groups like other.

5. Enter the server name of the machine on which JSServer
will run, including the network domain. For example, enter
demo.jsheet.com as the server name to specify that
JSServer will run on the machine demo in the domain
jsheet.com.
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6. If you are overwriting an existing installation of the JSheet
products and want to retain the existing user and group
permission files, choose the Maintain Existing
Information option when prompted.

7. Copy the jsserver.dat and jsbuilder.dat license files from
the root directory of the installation CD to the location
where JSheet is installed (the $JSHEET/JSServer and
$JSHEET/JSBuilder directories, respectively). The
environment variable JSHEET must be set to the
installation directory before running the JSheet Server.

After the environment is set up, use the command $JSHEET/bin/JSServer
to start the JSheet Server. Run $JSHEET/bin/JSBuilder to start JSBuilder.

Setting Up Your Web Server to Run
JSheet Demos
The HtmlDemo subdirectory of the $JSHEET directory needs to be added
as an available directory in your web server, either as a physical
directory in your default web path or as a virtual directory. To do this,
reference the directions for your specific web server software to ensure
you add the directory according to the requirements of your web server.
Once the HtmlDemo directory is available through your web server,
running the index.html file will provide links to the JSheet demos.

IMPORTANT: If you are copying the JSheet demo files to another
location, or creating .html files to work with JSServer, you must
reference the proper .jar and .js files. If you chose to install the Client
files, the .jar and .js files also will be placed in the $JSHEET/Client
directory for your convenience. These .jar files also can be copied to the
class path of your local browser for faster loading of the JSheet applets.
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Installing JSheet Documentation
IISC provides HTML documentation for the JSheet products in the
documentation directory of the CD. The files and folders in this directory
can be accessed from the CD or copied to your hard drive for local
access. Refer to the docs.htm file for information on the JSheet
documentation.
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Introducing JSServer
JSServer is the calculation engine that resides on the server with the web
server. The JSServer interface is detailed in this section.

The JSServer Menu Bar
When JSServer is launched, the menu bar, illustrated in the following
figure, is displayed.

The JSServer Menu Bar contains four menu items: Server,
Administration, Window, and Help.

Figure 1
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The Server Menu
The Server menu contains three menu items:

• Startup. Select Startup to start the server.

• Status. Select Status to display the Server Status dialog
box; information regarding connection and configuration is
contained in this dialog box.

• Shutdown. Select Shutdown to shut down JSServer. If
users are connected when you select Shutdown, additional
shutdown options (Graceful Shutdown, Delayed
Shutdown, and Immediate Shutdown) are presented.

When you select Graceful Shutdown, a warning is issued to all
connected users that the server will shut down in xx number of
minutes. Once all users have logged off, the server shuts down.

When you select Delayed Shutdown, a warning is issued to all
connected users that the server will shut down in xx number of
minutes. Once the designated number of minutes has expired,
the server shuts down, regardless of whether or not all users have
logged off.

When you select Immediate Shutdown, the server shuts down
without issuing a warning to connected users.

The Administration Menu
The Administration menu contains six menu items: Connections, Users
& Groups, Logging, Auditing, RealTime, and Preferences.

• Connections. Select Administration/Connections to
display open client connections, windows, and database
connections. When you select
Administration/Connections, the Connections dialog box
is displayed.



19Installation and Administration Guide

The Connections dialog box contains three tabs: Clients,
Windows, and ODBC Clients.

Click the Clients tab to display the Client Connections. Click
the radio buttons at the bottom of the tab to display the
connections ordered by user, host, or time. Use the Terminate
button to disconnect a user, or the Message button to send a
message to the connected user.

Click the Windows tab to display the Open Books. Click the
Show or Hide button at the bottom of the tab to perform the
specified action on the selected book. Check the Apply Option
To All Windows check box to view all of the open books.

Click the ODBC Clients tab to display the Database
Connections. To disconnect from a database, highlight the
database and click the Disconnect button.

• Users & Groups. Select Administration/Users & Groups
to add and remove users and groups. When you select
Administration/Users & Groups, the Users & Groups
dialog box is displayed.

The Users & Groups dialog box contains two tabs: User
Management and Group Management.

Click the User Management tab to add or delete a user, or to set
a password for a user. Click the Group Management tab to add,
delete, or edit a group or the members of a group.

IMPORTANT: When a user is deleted in JSBuilder, the
system administrator must manually delete the corresponding
folder in the user directory.

• Logging. To define session-specific logging settings, select
Administration/Logging/Configuration and indicate the
desired settings. Session-specific settings override the global
default logging settings that are defined using the
Administration/Preferences/Logging tab. Select



20

Administration/Logging/Start to initiate logging. Select
Administration/Logging/Stop to cease logging. Select
Administration/Logging/View to display the generated log
file.

When you select Administration/Logging/View, the View Log
File dialog box is displayed. Click the View The Whole Log
File radio button at the bottom right of the dialog box to display
the entire log file. Click the View Last 100 Lines radio button at
the bottom left of the dialog box to display only the last 100 lines
of the log file.

• Auditing. To define session-specific audit trail settings,
select Administration/Audit Trail/Configuration and
indicate the desired settings. Session-specific settings
override the global default audit trail settings that are defined
using the Administration/Preferences/Auditing tab. Select
Administration/Auditing/Start to initiate auditing. Select
Administration/Auditing/Stop to cease auditing. Select
Administration/Auditing/View to display the generated
audit file.

When you select Administration/Auditing/View, the View
Audit Trail dialog box is displayed. Click the View The Whole
Log File radio button at the bottom left of the dialog box to view
the entire audit trail log file. Click the View Last 100 Lines
radio button at the bottom right of the dialog box to display only
the last 100 lines of the audit trail log file.

• RealTime. When you select Administration/RealTime,
the RealTime dialog box is displayed. The Settings tab
contains configuration information and statistics regarding
realtime updates. The About tab contains information about
how to contact Investment Intelligence Systems Corporation,
as well as information about your JSheet product, including
the version number, serial number, and license status.
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• Preferences. Select Administration/Preferences to
display the Preferences dialog box and set global default
preferences. The Preferences dialog box contains ten tabs:
Format, Workbook, Paths, Logging, Auditing,
Connection, Environment, Delimiters, Realtime, and
Client.

The Format tab contains the options that control the appearance
of the data in your worksheets. Use the Font Name, Font Size,
Font Color, Font Alignment, Font Bold, Font Italic, and Font
Underline settings to specify the font name, size, color,
alignment, and style for all of the textual data you enter in your
worksheets. The text defaults also are used for row and column
headings, text in the entry bar, and text in the current cell
address.

Use the Number Format, Precision, Hide Zero, Show
Commas, Show Parenthesis, and Negative Color settings on
the Format tab to specify the number format, attributes,
precision, and negative number color for the numeric data you
enter in your worksheets. Use the Book Background Color
color picker to select the color you want to use as the
background color for your worksheet cell grid. The default is
white (RGB(255,255,255)).

Use the Public Read, Public Write, and Public Save settings on
the Workbook tab to specify the default public workbook
permissions. Use the Number of Sheets option to specify how
many worksheets will be available in a workbook. A workbook
can contain a maximum of 256 sheets.

Use the Paths tab to specify settings for the location where all
user workbooks are located, where the configuration files are to
be stored, and where the on-line documentation is to be installed.

Use the Logging tab to specify settings that control the enabling
of the log file, and whether or not to log serious errors, warnings,



22

connections, client requests, server responses, debug messages,
and callbacks.

Use the Auditing tab to specify settings that control enabling of
the audit file, and whether to audit connections, book
manipulation, sheet manipulation, data manipulation, database
activity, and range observers.

Use the Connections tab to specify the service identifier and
port, the number of client retries allowed, the bind port, and the
listen on port.

Use the Environment tab to specify the settings to customize the
display and behavior of the JSheet environment. Preferences
include settings that determine whether a new workbook is
created at launch; whether column headings are labeled with
numbers or letters; the behavior of the DELETE key, the ENTER

key, and the LEFT, RIGHT, UP, and DOWN arrow keys; the style of
dialog boxes invoked; whether keyboard shortcut keys appear on
the JSheet menus; the location of the toolbar; the placement of
windows on your desktop between JSheet sessions.

Use the Delimiters tab to specify how your text is delimited for
exported files and the default end-of-line separator.

Use the Realtime tab to specify the length of time, in seconds,
that a cell remains highlighted when it is updated due to a real-
time value change.

Use the Client tab to control the display of the components of
the workbook window (the format bar, formula bar, and status
bar). Select an option from the Cell Update Tracking
dropdown to activate the tracking of numeric changes made to
your worksheets. Use the Broken Connection Timeout setting
to select the number of seconds at which a broken connection is
timed out. Use the Rollover Year option to specify the 100-year
period for which 2-digit year input is allowed.
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The Window Menu
The Window menu contains three menu items: Show All, Hide All, and
Arrange Windows. In addition, a list of any open windows or dialog
boxes is displayed at the bottom of the Window menu.

• Show All. Select Window/Show All to show all of the
workbooks that currently are open by users who are
connected to the server.

• Hide All. Select Window/Hide All to hide all of the shown
workbooks.

• Arrange Windows. Select Window/Arrange Windows to
display the shown workbooks on the server in tiled, stacked,
or side-by-side arrangements. Select a window from the
window list to make that window the current window.

The Help Menu
The Help menu contains four menu items: Help, About JSServer,
License Information, and License Configuration.

• Help. Select Help/Help to access the JSheet online
documentation files.

• About JSServer. Select Help/About JSServer to display
the JSheet product logo and copyright information.

• License Information. Select Help/License Information to
display flex licensing and contact information. When you
select Help/License Information, the License Information
dialog box is displayed. This dialog box contains three tabs:
Information, Contact IISC, and View License.

Click the Information tab to display flex licensing information.
Click the Contact IISC tab to display contact information for
IISC. Internet addresses and telephone numbers for the London,
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New York, Kansas, Paris, and Toronto offices are listed. Click
the View License tab to display the IISC license file.

• License Configuration. Select Help/License
Configuration to display the License Configuration dialog
box. Use the controls in this dialog box to indicate the
product license type, number of users, host id, authorization
code, and license expiration date. Be certain you have no
open windows or workbooks, nor any connections with open
workbooks, before you select Help/License Configuration.
If any open windows or workbooks exist, an error message is
displayed when you select this menu command.
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Introducing JSServer Admin
JSServer Admin is a client tool for administrating the JSServer
configuration preferences. Using JSServer Admin, the administration of
JSServer can be controlled from a remote location. This provides an
extra layer of security, as well as increased extensibility to the product.

There are two methods of execution available to launch JSServer Admin.
The first method is to double-click the JSAdmin.jar file icon. The second
method is to run the application from the command line. To run
JSServer Admin from the command line, use the command:

java –jar JSAdmin.jar

NOTE: A JSDK or JRE of version 1.2.2 or higher must be used.

When JSServer Admin launches, the JSServer Admin window is
displayed, followed by the Connection Information dialog box, an
example of which is shown in the following illustration.
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To connect to the server:

1. Enter the server host address, your user name, and your
password into the Connection Information dialog box.

2. Press Connect. The status of the connection attempt is
displayed in the status bar of the JSServer Admin window.

If a connection is made, logging on is attempted. When a successful log-
on occurs, the tabbed panels become enabled for use, the Server panel is
displayed, as shown in the following illustration, and the Connection
Status icon in the bottom right corner of the Status Bar becomes green,
indicating a connected and logged on status.

If a connection or log-on attempt is unsuccessful, the reason for the
failure is displayed in the status bar and the Connection Status icon
remains red.

Figure 2
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The Connections Panel
After a connection and successful log-on have been made, click the
Connections tab to view the Connections panel; a list of client
connections is displayed. Each client is a hierarchical tree structure of
information. The user name and host name are displayed for each client,
as well as the connection time and connection ID. If a client has
workbooks open, this information can be viewed by expanding the client
tree-node. The client details listed can be sorted by different attributes,
such as By User, By Host, and By Time.

Status Bar

Server mode information

Connection status (i.e.,
listening for connections)

Configuration status (number of
current client connections,
including user and configuration
directories).

Figure 3
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To display the open workbooks, select Open Workbooks from the View
dropdown. In addition, you can select ODBC Connections from the
View dropdown to display the current ODBC connections.

Disconnecting a Connected Client
When the list of connected clients is displayed in the Connections panel,
you can elect to disconnect one or more of the clients from the server.
Simply select any user and click the Disconnect button at the bottom of
the Connections panel. A Disconnect Client Connection dialog box,
similar to the one shown below, is displayed.

This dialog box is populated with a list of all of the connected clients.
Select the user(s) to disconnect and indicate the type of disconnection
you want performed by clicking the corresponding radio button. Click
Yes to execute the disconnection, remove the user(s) from the

Figure 4

When Connections is
selected from the View
dropdown, the list of
clients currently
connected to the server is
displayed in the
Connection panel.

Click the View dropdown
arrow to display different
data in the Connections
panel.
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connections client list, and close the Disconnect Client Connection
dialog box.

Messaging a Connected Client
When the list of connected clients is displayed in the Connections panel,
you can elect to send a message to one or more of the clients connected
to the server. Select an initial recipient user and click the Message
button at the bottom of the Connections panel. A Send Message dialog
box, similar to the one shown below, is displayed.

Figure 5

Select this option to warn
the client of an impending
disconnection.

Select this option to
disconnect the client
without prior warning.

Figure 6

To send a message to all users,
click the All Users check box.

Type the message you want to
send in this text box. Then,
click the Send button in the
bottom right corner of the
dialog box to send the message
and close the dialog box.
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The Users & Groups Panel
Using JSServer Admin, you can easily maintain the users that are
allowed to connect to the server, as well as the various groups to which
the users may belong. To access the users and groups information, click
the User & Groups tab in the JSServer Admin window.

The Users Panel
Two panels are available on the Users & Groups tab: the Users panel
and the Groups panel. To indicate the panel you want to use, select the
corresponding option from the View dropdown list.

When Users is selected from the
View dropdown list, a list of
users registered on the server is
displayed in the Users section of
the panel.

Figure 7

Select a user from this list to
display the corresponding
membership details.

The groups to which the users
belong are displayed here.
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Adding a New User
To add a new user to the list of users that may connect to the server, click
the New button in the Users panel of the Users & Group tab. A New
User dialog box, similar to the one shown below, is displayed.

To add a new user:

1. In the User Name field, enter a maximum of 16 characters
for the name of the new user. The user name must be
unique from any existing user names.

2. In the Password field, enter a maximum of 8 characters
for the password of the new user.

3. Enter the password a second time in the Confirm
Password field.

4. When all of the information is entered correctly, click OK to
create the new user.

Figure 8
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Removing a User
It is very easy to remove a user. In the Users list in the Users panel of
the Users & Groups tab, simply select the user you want to remove and
click the Remove button. The user is removed from the list.

The Groups Panel
To view the Groups panel on the Users & Groups tab, select Groups
from the View dropdown list. The Groups panel, similar to the
illustration shown below, is displayed.

Adding a New Group
To add a new group to the list of groups registered on the server, click
the New button in the Groups panel of the Users & Group tab. A New
Group dialog box, similar to the one shown below, is displayed.

Figure 9

The groups that are
registered on the server
are displayed in this list.

When a group is selected in
the list, all of the members of
the group are listed here.
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In the text field, enter a maximum of 16 alphanumeric characters for the
name of the new group, and click OK to create the group. The group
name must be unique from any existing group names.

Removing a Group
It is equally easy to remove a group. In the Groups list in the Groups
panel of the Users & Groups tab, simply select the group you want to
remove and click the Remove button. The group is removed from the
list and all of the users assigned membership in the group are removed.

Editing a Group Account
There may be instances where you need to add or delete one or more
members from a group, but otherwise leave the group intact. To
accomplish this, you can edit the properties of a group account.

To edit a group account:

1. From the Groups panel of the Users & Groups tab, select
the group that you want to modify and click the Properties
button. An Edit Group dialog box similar to the one shown
below is displayed.

Figure 10
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The Available Users list on the left side of the dialog box
provides all of the registered users on the server that are
not currently in the selected group. The users listed on the
right side of the dialog box are all of the registered users
currently in the selected group.

2. To add a user to the group from the Available Users list,
select the user and click the Add button. To add all of the
users to the group, click the Add All button.

3. To remove users from the group, select the user in the
Group list and click the Remove button. Likewise, to
remove all of the users from the group, click the Remove
All button.

4. When all of the required changes have been made to the
group members, click OK to submit the changes to the
server and close the dialog box.

Figure 11
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The Workbook Defaults Panel
To establish and maintain the default formatting that is used for all of the
new workbooks shared on the system, use the settings available in the
Workbook Defaults panel. To display this panel, click the Workbook
Defaults tab in the JSServer Admin window. A panel similar to the one
shown in the following illustration is displayed.

Click the dropdown menus to select a different font, a different
alignment, or to specify a different number format. Check or uncheck
the various check boxes to enable or disable the corresponding
formatting values, such as boldfacing, underlining, displaying commas,

Figure 12
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and hiding zeroes. Check or uncheck the Read, Write, and Save
Permission check boxes to assign default permissions for workbooks.
Click the Pick Me buttons to display the Color Pick dialog box and
select a different color for the book background color, font color, and the
negative value color.

When the property values are accurately set, click Submit. The changes
are submitted to the server immediately.

The Client Panel
To establish and maintain the default view formatting for JSClient, use
the settings available in the Client panel. To display this panel, click the
Client tab in the JSServer Admin window. A panel similar to the one
shown in the following illustration is displayed.

Figure 13
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Check or uncheck the various check boxes to enable or disable the
corresponding formatting values, such as displaying the format bar, the
status bar, and the formula bar. Enter the Rollover Year, the
Connection Timeout information and the Duration information using
the corresponding arrow keys. Indicate the cell tracking color that you
want to use, the row and column headings style, the end of line separator,
and the text delimiter. When all of the values are entered correctly, click
Submit. The changes are submitted to the server immediately.

The Preferences Panel
To establish and maintain the properties used to configure the JSheet
Server, use the settings available in the Preferences panel. To display
this panel, click the Preferences tab in the JSServer Admin window. A
panel similar to the one shown in the following illustration is displayed.

Figure 14
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Check or uncheck the various check boxes to enable or disable the
corresponding properties, such as whether to begin the server on startup,
bind to an Orbix daemon, and send output IOR to a file. Enter the
service identifier, the service port number, and the number of client
retries to allow. When the information is entered correctly, click
Submit; the changes are sent to the server immediately.

The Logging Panel
To establish and maintain the properties used to define a specific logging
configuration and display the generated log file, use the settings available
in the Logging panel. To display this panel, click the Logging tab in the
JSServer Admin window. A panel similar to the one shown in the
following illustration is displayed.

Figure 15

Use this dropdown list
to select the section of
the log file that you
want to view.
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Different sections of the log file can be viewed. To display a specific
section of the log file, select the corresponding value from the View
dropdown list. The number of lines of the file that is displayed is set by
the Lines spinbox. The default value is 100 lines. The following options
are available in the View dropdown list:

• First X Lines. Select this option to view the beginning of
the log file.

• Last X Lines. Select this option to view the end of the log
file.

• Next X Lines. Select this option to view the next portion of
the log file.

• Jump Forward. Select this option to go forward in the file
x number of lines, equal to the previous number of lines
viewed.

• Jump Back. Select this option to go backward in the file x
number of lines, equal to the previous number of lines
viewed.

When the appropriate number of lines are selected for viewing, click
Refresh to retrieve and display the requested log entries.

Clearing the Log File
Press Clear to clear the server-generated log file. A dialog box prompts
you for confirmation. Select Yes to submit a request to the server to
clear its log file.

Editing the Logging Configuration
The settings that control the configuration for the JSServer Logging
features are contained in the Edit Logging Configuration dialog box.
To display this dialog box, click the Configuration button in the top
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right corner of the Logging panel. An Edit Logging Configuration
dialog box similar to the one shown below is displayed.

Check or uncheck the various check boxes to enable or disable the
corresponding properties. To modify the log file path, type a new value
path in the Log File Path field. When all of the information is specified
correctly, click OK to submit the changes to the server and close the
dialog box.

The Auditing Panel
The Auditing panel of JSServer Admin provides an easy way to monitor
the activities on the server. To display this panel, click the Auditing tab

Figure 16



41Installation and Administration Guide

in the JSServer Admin window. A panel similar to the one shown in the
following illustration is displayed.

From this panel, you can clear the audit file or list the activity of a
selected user. To update or refresh the audit information displayed, click
the Refresh button on the Auditing panel. The User list is updated and
the User Activity list is cleared. To clear the audit file, click the Clear
button on the Auditing panel.

To list the activity of a specific user, select the user from the User list in
the top portion of the panel. JSServer Admin displays the auditing
information for the selected user in the User Activity portion of the
panel: when the user logged on, the workbook(s) the user has open, and
the worksheet(s) that the user has created or opened.

Figure 17

The User list is
updated each time the
Refresh button is

This area of the panel
displays auditing
information specific to
the selected user.



42



43Installation and Administration Guide

Using the JSheet Load
Balancer
The JSheet Load Balancer is a Java application. All of the required Java
classes are held within the LoadBalancer.jar file, which must be in the
classpath. To run the Load Balancer application from the command line,
use the command:

java – cp loadbalancer.jar com.iisc.loadbalancer.LoadBalancer

The Load Balancer supports the following command line options:

Parameter Usage Min
Value

Max
Value

Default

noquery The noquery option stops the Load
Balancer from listening on the control port
for control process connections.

N/A N/A N/A

clientport This defines the port that the Load Balancer
uses to listen for client connections.

0 32768 5000

serverport This defines the port that the Load Balancer
uses to listen for server connections.

0 32768 5001

controlport This defines the port that the Load Balancer
users to listen for controller process
connections.

0 32768 5002

ping The ping option allows the rate of ping
messages from the Load Balancer to the
servers to be adjusted from the default of
five seconds.

1 300 5

usage (or ?) These print out a list of the valid arguments. N/A N/A N/A
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loglevel This defines the type of messages that are
logged by the system. The valid values are:
0 – no logging; 1 – log errors; 2 – as for
level 1 + log warnings; 3 – as for level 2 +
log diagnostic messages; 4 – as for level 3 +
log information messages.

0 4 1

logfile The name of the log file to which to output
messages. If none is specified, output is to
the console.

N/A N/A N/A

timerdelay This defines how long, in milliseconds, the
system pauses between each poll of the
server sockets for ping messages and
disconnect messages. Generally the shorter
the time, the more responsive the system is
but also the greater the processing power it
uses.

5 5000 500

alivetime This is the maximum time that a server can
remain in an alive state when it is not
responding to ping messages. The server
state is checked once per ping period after
80% of the ping period has expired. Setting
this value to less than the ping period means
that the server must respond promptly to
each ping message.

0 3600 4

suspecttime This is the maximum time that the server is
marked as suspect when it is not responding
to ping messages. A suspect server IOR
will only be given out to clients if no
servers are currently alive. If a server does
not respond within the suspect time, then it
is marked as dead.

0 3600 30

deadtime This is the maximum amount of time, in
seconds, that a server remains in the dead
state when it is not responding to ping
messages. Once the deadtime is exceeded,
the connection to the server is closed.

0 3600 300

pendingtime This is the amount of time, in milliseconds,
that a server or controller connection is
allowed to remain open with a message
being received from it. Once this time is
exceeded, the connection is closed.

0 30000 5000
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Use the following command line options to start as many JSServer
executables as are required for the load balancing:

JSServer.exe -loadbalancehost<host> -loadbalanceport<portnum> -master<no/yes/only>

The host and portnum parameters refer to the machine that is running the
Load Balancer and the server port of the Load Balancer, respectively.
The master parameter indicates how the server is treated by the Load
Balancer. A server that indicates that it is the master is used by any
clients that want to use shared books or by any clients that do not want to
use load balancing. A server with the master only setting is only used for
this; however, a server with the master yes setting is also used as a load
balancing server. A server with a master no setting is used only for load
balancing.

IMPORTANT: If a JSServer is being used for load balancing, it is no
longer possible for clients to connect to that server directly on port 5000.

In addition, clients can attach to the Load Balancer as if it were a
standard server. To use load balancing, they must specify -loadbalance
true on the command line.

How the Load Balancer Works
Load balancing works in a cooperative fashion with both the servers and
the clients. The load balancing process sits between the clients and
servers, intercepts IOR requests (defaults to port 5000), and provides
IORs to the clients that redirect them to a particular server in the cluster
of available servers.

In its simplest form, the Load Balancer sends the IOR of a server
randomly selected from a list of active servers. Once the IOR has been
sent to the client, the load balancing process then plays no further part in



46

the communications flow between client and server. This process is
illustrated in the following drawing.

While this is a relatively simple process, it does have the significant
drawback that it is not possible to properly handle shared books. At the
point that the client requests the IOR from the Load Balancer, the Load
Balancer does not know what books the client wants to open and whether
they are to be shared or not. If the client wants to share a book already
open on server x and the load balancer directs it to server y, then it will
not be able to use the book in a cooperative fashion.

Future releases of the Load Balancer will address this issue. However,
for now, the Load Balancer provides two IORs to each client. The first
IOR always refers to the same server and can be used for shared books.
The second IOR is a randomly selected server from the list of known
servers. If the client is aware of the load balancing and knows that the
books are single-user, the second IOR can be used to open the book.
This form of load balancing is designed to be used primarily in HTML
pages where a book to open is specified as a parameter to the applet and
it is known at design time that the book is not shared. The designer can
then pass an additional parameter to the applet to tell it to use the second
IOR to open the book.

When the servers register with the load balancing process, one of them
indicates that it should be used as the server for shared books; this server

Load Balancer JSheet Client

JSheet Server

(1) Client requests

(2) IORs sent to

(3) Client

Figure 20
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is referred to as the master server. The master server can indicate
whether it is a potential candidate for the second IOR or whether it
should only be used for the first IOR.

The steps involved in load balancing are diagrammed in the following
drawing.

In step 1, a JSServer process contacts the Load Balancer process to
inform it that it is ready to accept incoming requests. It defines itself as
the “master” JSServer process. Therefore, the first IOR supplied to the
clients will be the IOR of this process. It also indicates that it wishes to
be added to the list of load balancing servers, which means that it may be
provided as the second IOR, as well as always being the first IOR sent to
the client.

In step 2, a second JSServer process informs the Load Balancer that it is
ready to accept incoming requests.

JSServer

JSServer
(master)

JSheet Client
(non-load balancing)

JSheet Client
(load balancing)

(1

(2

(3

(5 (4

(6

Figure 21

Load Balancer
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In step 3, a JSheet client contacts the Load Balancer to request IORs.
The Load Balancer returns the IOR of the master JSServer as the first
IOR and the IOR of the second server as the second IOR.

In step 4, the client is unaware of load balancing or specifically does not
want to use load balancing because it is opening a shared book. In this
case, it uses the first IOR to make a connection to the master server. It
has no further communication with the load balancer.

In step 5, a second client contacts the Load Balancer for IORs. The Load
Balancer returns the IOR of the master JSServer as the first IOR and the
IOR of the second server as the second IOR.

In step 6, the client knows that the sheet it wants to open is not shared
and so it connects to the server given by the second IOR.

The Load Balancer attempts to monitor the state of each server that it
knows about. If a server appears to have died, it attempts to route clients
to servers that are “alive.”
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